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History of Changes 

Issue Date Summary 

1 05/2022 First issue of the guide 

2 08/2024 Added: 

3.9 Processes crash/Memory leak  

 

Document Scope 
 
Diagnostic Data 
In order, to trouble shoot a problem in an OpenScape Contact Center system, it is necessary to collect and 
investigate the available diagnostic data. This document describes which diagnostic data is available of the 
various components of an OpenScape Contact Center system, as well as which relevant diagnostic data for 
OpenScape Contact Center is available of the involved 3rd party components. Further, the document describes 
where in the OpenScape Contact Center system the diagnostic data can be found. 
 
Trouble Shooting 
Once it is known in which (suspected) component(s) of the OpenScape Contact Center system the problem is 
located and once it is known which diagnostic data is available for such component along with its location, the 
corresponding diagnostic data can be collected for investigation. To facilitate the decision about which 
diagnostic data is to be collected, this document lists problematic scenarios in an OpenScape Contact Center 
system along with the associated diagnostic data to be collected. 
 
How-To-Solve 
Finally, this document describes How-To instructions, in order to solve some specific problematic scenarios. 
 
 
Abbreviations 
 
In this document the following common abbreviations will be used. 
 

OSCC OpenScape Contact Center 

OSCMS OpenScape Contact Media Service 

OSV OpenScape Voice 

OS4000 OpenScape 4000 

OSBiz OpenScape Business 
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1 Troubleshooting Scenarios 

This section lists common scenarios and shows for each scenario which 

diagnostics need to be collected for investigation by GVS/DEV in the 

problematic case. 

  

1.1 OSCC Media  

Depending on the medium of the problematic scenario the necessary 

diagnostics are different. The various media are Voice, Callback, Email, 

Web Collaboration and Open Media. 

1.1.1 Voice 

Section Diagnostic 

2.1.3 OSCC Main Server 

• OSCC Design Database 

2.1.4 

 

OSCC Main Server 

• OSCC Servers » Call Director 

• OSCC Servers » Telephony 

• OSCC Servers » Presence 

• OSCC Servers » Routing 

2.2.1 OSCC Application Server 

• OSCC Applications » Agent Portal Web 

2.5.2 OSCC Client Manager 

• OSCC Error Log 

2.5.4 OSCC Client Manager 

• OSCC User Activity Report 

2.5.7 OSCC Client 

• OSCC Agent Portal Web Front-End 

2.6.1 

 

OSCMS Server 

• OSCMS Applications » Announcement Ports Call Director 

• OSCMS Applications » Basic IVR Call Director 

2.6.3 

 

OSCMS Server 

• OSCMS Media Server 

3.4 optional Communication Platform 

• OSV, or 

• OS4000, or 

• OSBiz 
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1.1.2 Callback 

Section Diagnostic 

2.1.3 OSCC Main Server 

• OSCC Design Database 

2.1.4 

 

OSCC Main Server 

• OSCC Servers » Callback 

• OSCC Servers » Telephony 

• OSCC Servers » Presence 

• OSCC Servers » Routing 

2.2.1 OSCC Application Server 

• OSCC Applications » Agent Portal Web 

2.5.2 OSCC Client Manager 

• OSCC Error Log 

2.5.4 OSCC Client Manager 

• OSCC User Activity Report 

2.5.7 OSCC Client 

• OSCC Agent Portal Web Front-End 

3.4 

optional 

Communication Platform 

• OSV, or 

• OS4000, or 

• OSBiz 

1.1.3 Email 

Section Diagnostic 

2.1.3 OSCC Main Server 

• OSCC Design Database 

2.1.4 

 

OSCC Main Server 

• OSCC Servers » Email 

• OSCC Servers » Presence 

• OSCC Servers » Routing 

2.1.7 OSCC Main Server 

• Informix Tools » Database Table Unload » Table “emmessages” 

2.2.1 OSCC Application Server 

• OSCC Applications » Agent Portal Web 
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2.5.2 OSCC Client Manager 

• OSCC Error Log 

2.5.4 OSCC Client Manager 

• OSCC User Activity Report 

2.5.7 OSCC Client 

• OSCC Agent Portal Web Front-End 

3.5 Corporate Email Server 

optional Network Traffic between OSCC Email Server and Corporate Email Server 

 

1.1.4 Web Collaboration 

Section Diagnostic 

2.1.3 OSCC Main Server 

• OSCC Design Database 

2.1.4 

 

OSCC Main Server 

• OSCC Servers » Presence 

• OSCC Servers » Routing 

• OSCC Servers » Web Interaction 

2.2.1 OSCC Application Server 

• OSCC Applications » Agent Portal Web 

2.5.2 OSCC Client Manager 

• OSCC Error Log 

2.5.4 OSCC Client Manager 

• OSCC User Activity Report 

2.5.7 OSCC Client 

• OSCC Agent Portal Web Front-End 

3.6 Corporate Web Server 

optional Network Traffic between OSCC Web Interaction Server and Corporate Web 

Server 
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1.1.5 Open Media Facebook, Twitter & WhatsApp 

Section Diagnostic 

2.1.3 OSCC Main Sever 

• OSCC Design Database 

2.1.4 OSCC Main Server 

• OSCC Servers » Open Media 

• OSCC Servers » Presence 

• OSCC Servers » Routing 

2.2.1 OSCC Application Server 

• OSCC Applications » Agent Portal Web 

• OSCC Applications » Open Media REST API 

2.3 OSCC Open Media Connector Server 

• Facebook, or 

• Twitter, or 

• WhatsApp 

2.5.2 OSCC Client Manager 

• OSCC Error Log 

2.5.4 OSCC Client Manager 

• OSCC User Activity Report 

2.5.7 OSCC Client 

• OSCC Agent Portal Web Front-End 

1.2 OSCC REST API Applications 

1.2.1 Open Media REST API 
The customer has integrated Facebook, Twitter, WhatsApp, or an own Medium application for 

exchanging text-based messages between the caller and the Agent Portal Web user. The application 

is installed on the OSCC open media connector server and communicates through the OSCC 

application server and the OSCC open media REST API with the OSCC open media server on 

the OSCC main server.  

Documentation OpenScape Contact Center Enterprise 

Open Media Framework – Programming Guide 

 

     For the diagnostics, see section Open Media Facebook, Twitter & WhatsApp. 
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1.2.2 Web Interaction REST API 

The customer has integrated an application based on the webinteractionsdkexample, or an 

own Web application for exchanging chat messages between the caller and the Agent Portal 

Web user. The application is installed on the corporate web server and communicates through 

the OSCC application server and the OSCC web interaction REST API with the OSCC web 

interaction server. 

Documentation OpenScape Contact Center Enterprise 

Web Interaction REST API – Programming Guide 

For the diagnostics, see section OSCC Media > Web Collaboration. In addition, collect the     

following diagnostics, as the OSCC application server is involved as well. 

Section Diagnostic 

1.2.1 OSCC Application Server 

• OSCC Applications » Web Interaction REST API 

Documentation OpenScape Contact Center Enterprise 

Web Interaction REST API – Programming Guide 

For the diagnostics, see section OSCC Media > Web Collaboration. In addition, collect the 

following diagnostics, as the OSCC application server is involved as well. 

Section Diagnostic 

1.2.1 OSCC Application Server 

• OSCC Applications » Web Interaction REST API 

1.2.3 OSCC Client REST API 

The customer has integrated a Client application for users handling contacts in OSCC. The users 

use this client instead of the standard OSCC Agent Portal Web application. This custom 

application has been developed by a 3rd party developer. The application can send commands 

to OSCC and can receive events from OSCC. The application is installed in the customer 

environment, where applicable, and communicates through the OSCC application server and the 

OSCC Client REST API with the various OSCC servers on the OSCC main server. 

 

Documentation OpenScape Contact Center Enterprise 

REST SDK Framework – Programming Guide 

For the diagnostics, depending on the involved media of the problematic scenario, see section 

OSCC Media, and in addition the following diagnostics. 

 

Section Diagnostic 
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1.2.1 OSCC Application Server 

• OSCC Applications » OSCC Client REST API 

NOTE: An OSCC Client REST API test tool is available and can be obtained from GVS OSCC. The 

test tool has implemented various functionalities, with which commands sent by the test tool and 

events returned by the OSCC system can be tested in the customer environment. 

This feature is not available for OpenScape 4000. 

1.3 OSCMS Applications 

1.3.1 WebRTC Integrated Phone & WebRTC Video/Screen 
Share 

With WebRTC Integrated Phone the user can handle voice contacts through the Agent Portal 

Web application without the need of a physical phone.  

With WebRTC Video/Screen Share the user can handle voice contacts through the Agent Portal 

Web application, while sharing the camera or the screen with another internal Agent Portal Web 

user or with an external caller, which latter uses the Click-to-Contact functionality. The Click-to 

Contact component is then embedded in the customer’s web application on the corporate web 

server. 

Documentation OpenScape Contact Center Enterprise 

WebRTC – Description Guide 

OpenScape Contact Media Service – Installation Guide 

 

Section Diagnostic 

2.1.3 OSCC Main Server 

• OSCC Design Database 

2.1.4 OSCC Main Server 

• OSCC Servers » Call Director 

• OSCC Servers » Telephony 

• OSCC Servers » Presence 

• OSCC Servers » Routing 

2.2.1 OSCC Application Server 

• OSCC Applications » Agent Portal Web 

2.5.2 OSCC Client Manager 

• OSCC Error Log 

2.5.4 OSCC Client Manager 

• OSCC User Activity Report 
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2.5.7 OSCC Client 

• OSCC Agent Portal Web Front-End 

2.6.1 OSCMS Server 

• OSCMS Applications » Announcement Ports Call Director 

• OSCMS Applications » Basic IVR Call Director 

• OSCMS Applications » WebRTC Integrated Phone 

• OSCMS Applications » WebRTC Video/Screen Share  

2.6.3 OSCMS Server 

• OSCMS Media Server 

3.3.2 Linux Server 

• Linux Network Traffic 

- Topology of involved resources 

In case the Click-to-Contact functionality is part of the scenario, then additional diagnostics are   

necessary. 

 
2.1.4 OSCC Main Server 

• OSCC Servers » Web Interaction 

2.2.1 OSCC Application Server 

• OSCC Applications » Web Interaction REST API 

3.6 Corporate Web Server 

optional Network Traffic between OSCC Application Server and Corporate Web Server 

1.3.2 REST SDK 
The REST SDK on the OSCMS Server is used by Call Recorder, Outbound Dialer and Customer 

Satisfaction. See, the following sections. 

1.3.3 Call Recorder 
The voice conversations of the Agent Portal Web user can be recorded if his extension is configured 

for this purpose. All voice conversations of the user are recorded automatically. In the Agent Portal 

Web application, the user can manually stop and start recordings on demand. In the Web Supervisor 

application, the user can search for recordings and download or listen to them. 

Documentation OpenScape Contact Center Enterprise 

OpenScape Contact Media Service – Installation Guide 

 

 

Section Diagnostic 

2.1.3 OSCC Main Server 

•      OSCC Design Database 
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2.1.4 OSCC Main Server 

• OSCC Servers » Telephony 

2.2.1 OSCC Application Server 

• OSCC Applications » Agent Portal Web 

• OSCC Applications » Web Supervisor 

2.5.7 OSCC Client 

• OSCC Agent Portal Web Front-End 

2.6.1 OSCMS Server 

• OSCMS Applications » Call Recorder 

• OSCMS Applications » REST SDK 

3.4 

optional 

Communication Platform 

• OSV, or 

• OS4000 

1.3.4 Outbound Dialer 
Automatic outbound calls can be generated on configured extensions and upon successful connection 

with the called party (customer), the customer will be connected with either the Agent Portal Web 

user to start the conversation or will be connected with the OSCMS Voice Portal for further call 

handling. 

 

Documentation OpenScape Contact Center Enterprise 

OpenScape Contact Media Service – Installation Guide 

 

Section Diagnostic 

2.1.3 OSCC Main Server 

• OSCC Design Database 

2.1.4 OSCC Main Server 

• OSCC Servers » Telephony 

• OSCC Servers » Presence 

• OSCC Servers » Routing 

2.2.1 OSCC Application Server 

• OSCC Applications » Agent Portal Web 

2.5.2 OSCC Client Manager 

• OSCC Error Log 

2.5.4 OSCC Client Manager 

• OSCC User Activity Report 
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2.5.7 OSCC Client 

• OSCC Agent Portal Web Front-End 

2.6.1 OSCMS Server 

• OSCMS Applications » Outbound Dialer 

• OSCMS Applications » REST SDK 

2.6.2 OSCMS Server 

• OSCMS Voice Portal Nuance (if part of the scenario) 

2.6.3 OSCMS Server 

• OSCMS Media Server 

1.3.5 Customer Satisfaction CSAT 

After the voice conversation between the caller and the Agent Portal Web user has finished, the 

caller can be transferred to a Customer Satisfaction survey in which the caller is prompted to 

answer one or more questions in an automatic process. 

Documentation OpenScape Contact Center Enterprise 

OpenScape Customer Satisfaction Survey – User Guide 

Depending on the operation mode of the customer satisfaction survey, more or less 

components are involved in the scenario, which defines the diagnostics to be collected in the 

problematic case. Customer satisfaction survey can be operated: 

▪ Without OSCC Call Director, OSCMS Voice Portal and Third Party IVR integration. 

▪ With OSCC Call Director integration. 

▪ With OSCMS Voice Portal or 3rd Party IVR integration. 

Section Diagnostic depending on operation mode 

2.1.3 OSCC Main Sever 

• OSCC Design Database 

2.1.4 OSCC Main Server 

• OSCC Servers » Call Director 

• OSCC Servers » Telephony 

• OSCC Servers » Presence 

• OSCC Servers » Routing 

2.2.1 OSCC Application Server 

• OSCC Applications » Agent Portal Web 

2.6.1 OSCMS Server 

• OSCMS Applications » Announcement Ports Call Director 

• OSCMS Applications » Basic IVR Call Director 

• OSCMS Applications » Customer Satisfaction 

• OSCMS Applications » REST SDK 

2.6.2 OSCMS Server 
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• OSCMS Voice Portal Nuance 

2.6.3 OSCMS Server 

• OSCMS Media Server 

1.4 Virtual Agent Chat Bot & Speech Bot 

The Virtual Agent can handle contacts of a caller on text or voice basis without the  involvement 

of a human contact center user. In the former case the virtual agent is called Chat Bot and in the 

latter case the virtual agent is called Speech Bot. For the chat bot the OSCC application server 

is involved. For the speech bot the OSCC application server as well as the OSCMS server is 

involved. 

The text contact is handled by the Chat Bot while automatically exchanging text messages with 

the caller with Google Dialogflow, which is a Natural Language Understanding (NLU) platform. 

The chat bot can be combined with the OSCC Open Media Connector for Facebook, Twitter, 

or WhatsApp. 

The voice contact is handled by the Speech Bot while automatically exchanging voice messages 

with the caller with a Speech Recognizer (ASR) and a Text Vocalizer (TTS). This requires the 

involvement of OSCMS Voice Portal. 

 

Documentation OpenScape Contact Center Enterprise 

Virtual Agent REST API Framework – Programming Guide 

Virtual Agent Connector – Deployment Guide 

Web Manager – Administration Guide 

OpenScape Contact Media Service – Installation Guide Speech Bot only 

    Chat Bot 

Section Diagnostic  

2.1.3 OSCC Main Sever 

• OSCC Design Database 

2.1.4 OSCC Main Server 

• OSCC Servers » Presence 

• OSCC Servers » Routing 

2.2.1 OSCC Application Server 

• OSCC Applications » Virtual Agent  

2.3 OSCC Open Media Connector Server 

• Facebook, or 

• Twitter, or 

• WhatsApp 
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2.4 

 

OSCC Virtual Agent Connector Server 

• Virtual Agent 

    Speech Bot 

Section Diagnostic  

2.1.3 OSCC Main Sever 

• OSCC Design Database 

2.1.4 OSCC Main Server 

• OSCC Servers » Call Director 

• OSCC Servers » Telephony 

• OSCC Servers » Presence 

• OSCC Servers » Routing 

2.2.1 OSCC Application Server 

• OSCC Applications » Virtual Agent 

2.4 

 

OSCC Virtual Agent Connector Server 

• Virtual Agent 

2.6.1 OSCMS Server 

• OSCMS Applications » Virtual Agent Speech Bot 

2.6.2 OSCMS Server 

• OSCMS Voice Portal Nuance 

2.6.3 OSCMS Server 

• OSCSCM Media Server 

1.5 OSCC Reporting 

Reporting is the presentation of statistical data, which is stored in the OSCC database, to a view 

in the OSCC Manager application, or to a file in a certain format. The OSCC statistics server 

manages the statistical data in the database. The OSCC real time server brings the statistical 

data from the OSCC server to the OSCC Manager application to display in a view. The OSCC 

reporting server generates out of the statistical data, the report for presentation in a view or a file. 

The content of the view or file depends on which statistical data was requested to be reported. 

 

Section Diagnostic  

2.1.3 OSCC Main Sever 

• OSCC Design Database 

2.1.4 OSCC Main Server 

• OSCC Servers » Telephony|Callback|Email|Web Interaction|Open Media 

• OSCC Servers » Presence 

• OSCC Servers » Real Time 
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• OSCC Servers » Reporting 

• OSCC Servers » Statistics 

2.1.6 OSCC Main Server 

• Informix Logs 

2.1.7 OSCC Main Server 

• Informix Tools » Database Check 

• Informix Tools » Database Spaces and Chunks 

• Informix Tools » Database Schema 

• Informix Tools » Database Table Unload 

2.4.2 OSCC Client Manager 

• OSCC Error Log 

2.4.5 OSCC Client 

• OSCC Manager 

1.6 Chat-between-Agents 

    Two Agent Portal Web users can exchange chat messages between each other. 

 

Section Diagnostic  

2.1.3 OSCC Main Sever 

• OSCC Design Database 

2.1.4 OSCC Main Server 

• OSCC Servers » Administration 

2.1.5 OSCC Main Server 

• OSCC Openfire 

2.2.1 OSCC Application Server 

• OSCC Applications » Agent Portal Web 

2.5.2 OSCC Client Manager 

• OSCC Error Log 

2.5.4 OSCC Client Manager 

• OSCC User Activity Report 

2.5.7 OSCC Client 

• OSCC Agent Portal Web Front-End 
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1.7 Directory LDAP 

The Agent Portal Web user can extract manually information from a Directory about the party to be 
called. The Agent Portal Web user can get automatically displayed information from a directory about 
the caller, which was routed to him. 

Section Diagnostic  

2.1.3 OSCC Main Sever 

• OSCC Design Database 

2.1.4 OSCC Main Server 

• OSCC Servers » Telephony 

• OSCC Servers » Presence 

• OSCC Servers » Routing 

2.2.1 OSCC Application Server 

• OSCC Applications » Agent Portal Web 

2.4.7 OSCC Client 

• OSCC Agent Portal Web Front-End 

optional Network Traffic between OSCC Application Server and Corporate LDAP 

Server 

 

1.8 Replication 

In a High Availability system, there are two OSCC main servers (Node 1 and Node 2) and an optional 

OSCC central reporting server (CRS). Data is automatically replicated between the servers on the 

level of Informix. 

 

Section Diagnostic  

2.1.3 OSCC Main Sever 

• OSCC Design Database 

2.1.6 OSCC Main Sever 

• Informix Logs 

2.1.7 OSCC Main Server 

• Informix Tools » Replication States 

2.1.8 OSCC Main Server 

• Replication Tool 

3.1.6 Windows Server 

• Windows Cluster Log 
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3.1.7 Windows Server 

• Windows Cluster Event Log 

3.1.8 Windows Server 

• Windows Cluster Validation Report 

 

   Additionally, the following diagnostic data can be helpful. 

 

   Replication States 

In the Windows command prompt cmd under the informix user on both OSCC main   servers and on 

the OSCC central reporting server, execute the cdr list server command. It displays a list of the 

replication servers along with the replication states, that are visible to the server on which the 

command is run. 

 

 
 
 
 

 

 
SERVER            ID   STATE    STATUS      QUEUE       CONNECTION CHANGED   
g_itqacd1          2   Active   Dropped     257442331   Aug 08 16:02:57  
g_itqacd2          3   Active   Local       0                 
g_itqacdreporting  1   Active   Connected   1425        Jul 23 19:30:06 

 
The status should be connected, and buffered data in the queue should be low. The queue will grow if 

data cannot be replicated to the other side. In order to start replication on a dropped connection, the 

command cdr start can be attempted. If the queue is very big, it can be advisable to start replication 

along with emptying the queue, which is done with the command cdr cleanstart. In that case the data, 

not yet being replicated, is lost from the buffer and must be replicated manually later on. 

Command 

cdr start 

cdr cleanstart 

 
If replication still will not work, consider removing the replication completely and configure    the 

replication from scratch, according the OSCC installation guide. 

 

Ping & Nslookup 

In the Windows command prompt cmd on both OSCC main servers and on the OSCC 

central reporting server, execute the ping and nslookup commands. The servers must be reachable, 

the results must be consistent, and no issues must occur. In case of inconsistent results, contact your 

network administrator. 

Command 

ping -4 <node1_MachineName> 

ping -4 <node2_MachineName> 

Command 

cdr list server > C:\Temp\cdr-<node1|node2|crs>.txt 
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ping -4 <crs_MachineName> 

 

ping -4 <node1_IP_Address> 

ping -4 <node2_IP_Address> 

ping -4 <crs_IP_Address> 

 

ping -4 <node1_FQDN> 

ping -4 <node2_FQDN> 

ping -4 <crs_FQDN> 

 

Command 

nslookup <node1_MachineName> 

nslookup <node2_MachineName> 

nslookup <crs_MachineName> 

 

nslookup <node1_IP_Address> 

nslookup <node2_IP_Address> 

nslookup <crs_IP_Address> 

 

nslookup <node1_FQDN> 

nslookup <node2_FQDN> 

nslookup <crs_FQDN> 

 

Anti-Virus 

Check, that an anti-virus application does not access and block (temporarily) any OSCC folder. 
 
NetSetup and ShareData folders 

Check, that each of the servers can access the NetSetup and ShareData folders of each of the other 
servers. 
 

Database spaces and database chunks 

Check, that no database space is (almost) full. Eventually a new database chunk must be added 
manually. For details, see section 4.3. 
 

IPv6 

Check, that IPv6 is disabled for Informix by the Windows environment variable IFX_DISABLE_IPV6, 
which must have value 1. If nothing is returned by the set command, then configure that variable in 
Windows accordingly. 

 

Command 

set | findstr IFX 
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      Multiple Network Cards 

If the server has multiple network cards, then in the SQLHOSTS key of the Windows Registry there 
must be no asterisk (*) in front of the server names. 

 

Registry Key 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Informix\SQLHOSTS 

Note on the contrary, that in the Windows SQLHosts file, there must be an asterisk in front of the 
server names if the server has multiple network cards. This character is then automatically set when 
the replication is configured with the trcdbins tool. 

 
Informix log 

The Informix log can grow excessively. In case the file is very big, consider cleaning the log after its 
backup. See section 2.1.6. 
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1.9 External IVR 

The external IVR machine can be integrated in OSCC by either using the OSCC IVR API or 

by using the OSCC VoiceXML API. 

OSCC IVR API 

Section Diagnostic  

2.1.3 OSCC Main Sever 

• OSCC Design Database 

2.1.4 

 

OSCC Main Server 

• OSCC Servers » Telephony 

• OSCC Servers » Routing 

3.4 

optional 

Communication Platform 

• OSV, or 

• OS4000, or 

• OSBiz 

3.7.1 

 

External IVR Machine 

• External IVR and OSCC IVR API 

 

  OSCC VoiceXML API 

  This is a web-based solution with the involvement of a corporate web server to gather 
information by VoiceXML subdialogs. The IVR interacts with the OSCC server through the 
corporate web server. The OSCC web interaction server acts as entry point for the requests. 

 

Section Diagnostic  

2.1.3 OSCC Main Server 

• OSCC Design Database 

2.1.4 

 

OSCC Main Server 

• OSCC Servers » Telephony 

• OSCC Servers » Routing 

• OSCC Servers » Web Interaction 

3.4 

optional 

Communication Platform 

• OSV, or 

• OS4000 

3.6 Corporate Web Server 

3.7.2 

 

External IVR Machine 

• External IVR and OSCC Voice XML API 
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2 OSCC Diagnostic Data 

2.1 OSCC Main Server 

2.1.1 OSCC Server Startup 
The OSCC server is started-up by the initialization of the OSCC watchdog server and the OSCC 

administration server. The diagnostics of the initializations of these components are written 

before the usual diagnostics of these servers are written, see section OSCC Servers. 

Server Diagnostic  

Watchdog twdsrvr.00x 

Administration tsmsrvr.00x 

 

Location 

C:\Program Files (x86)\OpenScape\Contact Center 

 

2.1.2 OSCC Installation 
During the OSCC server installation with a Microsoft Installer msi file, the OSCC software, the 

Informix software and the Informix database are being installed resp. created. 

     

Diagnostic 

OpenScape Contact Center <release version> Server - HppcInstall.log  

OpenScape Contact Center <release version> Server - HppcInstall2.log 

 

Location 

C:\Program Files (x86)\OpenScape\Contact Center\Tmp 

 

Once the OSCC software and the Informix software have been installed, subsequently the Informix 

database will be created by the OSCC tool tindbins with all necessary OSCC tables and columns. 

The previous logs will refer to the diagnostic file of this component. 

     

Diagnostic 

tindbins.00x 

 

Location 
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C:\Program Files (x86)\OpenScape\Contact Center\ShareData\DIAGS 

 

OSCC Patch Installation 

An existing OSCC system can be upgraded by installing a patch with a Microsoft Installer msp file. 

The diagnostics for a patch installation are written in the log files mentioned above. Alternatively, 

another installation log can be obtained, which contains more details than the mentioned installation 

log files. The patch is then installed via the Windows command prompt cmd under the Administrator 

user. 

 

Command 

runas /user:Administrator cmd 

msiexec /qb /p "<patch-name>.msp" /L*v C:\Temp\OSCCPatch.log 

 

       OSCC Database Export/Import 

Part of the OSCC server installation or upgrade process is optionally a manual export and subsequent 

import of the OSCC database by the corresponding utilities osccexport.cmd and osccimport.cmd.  

 

The export utility will generate a log file and an ini file for the subsequent import, as well as the 

database export unl files for the subsequent import.  

Command 

osccexport.cmd C:\Temp\export-import 

 

Location 

C:\Temp\export-import\OSCCImport.log 

C:\Temp\export-import\tindbins.ini 

 

2.1.3 OSCC Design Database 
The OSCC design database can be either manually saved from the OSCC production database by 

the Manager application, see section OSCC Client machine, or, if configured, will be automatically 

stored around data maintenance time. 

     

Location 

C:\Program Files (x86)\OpenScape\Contact Center\ShareData\AdministrationData 

 

2.1.4 OSCC Servers 
On the OSCC main server various servers are running, depending on the licensed and activated 

feature set. Consequently, not all mentioned servers must write diagnostic data. 
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Section Diagnostic  

Administration AdministrationServer_<machinename>.00x 

Callback CallbackServer_<machinename>.00x 

Call Director CallDirectoServerr_<machinename>.00x 

Config Sync ConfigSyncServer_<machinename>.00x 

Data Management DataManagementServer_<machinename>.00x 

Email EmailServer_<machinename>.00x 

Open Media OpenMediaServer_<machinename>.00x 

Presence PresenceServer_<machinename>.00x 

Real Time RealTimeServer_<machinename>.00x 

Reporting ReportingServer_<machinename>.00x 

Routing RoutingServer_<machinename>.00x 

Statistics StatisticsServer_<machinename>.00x 

Telephony TelephonyServer_<machinename>.00x 

Watchdog WatchdogServer_<machinename>.00x 

Web Interaction WebinteractionServer_<machinename>.00x 

 

Location 

C:\Program Files (x86)\OpenScape\Contact Center\ShareData\DIAGS 

 

Diagnostic Level 

The diagnostic level for each of the servers is set in the OSCC System Monitor application. For those 
servers, which are thought to be involved in the problematic scenario, set the diagnostic level to Debug 
and keep the diagnostic level for the other servers on Default. On heavy load systems consider the 
diagnostic level to set at least to Information, instead of Debug. GVS or DEV may request certain 
diagnostic levels, which can be set via Custom. In reproducible scenarios consider, to reset the 
diagnostic level back to Default, after the scenario has been captured. 

 
If size and transmission time of the diagnostics are not relevant, collect all the diagnostics of the whole 
directory (independent of time stamp and suspected problematic server). Otherwise, sort the 
diagnostics by column Date Modified and delete all older diagnostics not covering the scenario. 
In case the diagnostics needs to be captured for a longer time frame, or will be overwritten too fast, 
consider, to use a file copy tool.   
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2.1.5 OSCC Openfire 
In the Openfire Admin Console, the trace level Debug can be enabled in Server Manager > Logs > 

Tab Debug. The other trace levels Error, Warn and Info are written by default. 

Diagnostic  

error.log 

warn.log 

info.log 

debug.log 

 

Location 

C:\Program Files (x86)\OpenScape\Contact Center\OpenFire\logs 

 

2.1.6 Informix Logs 

Diagnostic  

ol_<servername>.log 

olsrvice.log   

 

Location 

C:\Program Files (x86)\Informix 

 

Note: The Informix log can grow excessively. In case the file is very big, consider clearing the log 

after its backup or re-storage. E.g., the last 10000 lines can be re-stored into a new file with the 

Powershell command Get-Content. 

 

Powershell Command 

Get-Content -tail 10000 ol_<servername>.log > C:\Temp\informix-<date>.log 

 

If during the 15-minutes roll-ups, data of the temporary database tables cannot be written to the 
permanent database tables, then this temporary data is exported by the OSSC system to files. This 
can happen permanently, e.g., due to a corrupt index of the Informix table, or occasionally, e.g., due 
to a temporary lock of the Informix table. See section 4.2. 

Export Files 
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<tablename>1_<date_time>.exp 

<tablename>2_<date_time>.exp 

 

Location 

C:\Program Files (x86)\OpenScape\Contact Center 

 

2.1.7 Informix Tools 
There are some useful diagnostic Informix commands and utilities listed below, to be executed in 

the Windows command prompt cmd under the informix user. The output can be written to a file in 

Windows Notepad txt format. 

Command 

runas /user:informix cmd 

 

Database Check 

The oncheck utility checks specified disk structures for inconsistencies, repairs inconsistent index 

structures, and displays information about disk structures. This utility is to be executed outside 

business hours, as it can automatically make corrections on the database. 

Command 

oncheck -cDIx hppcdb > C:\Temp\oncheck.txt 

 

Database Spaces and Chunks 

The output of the onstat command shows in the upper part the database spaces and in the lower 

part the database chunks. Each database space has one or more database chunks. Each database 

chunk number is associated with a database space number. For each database chunk its location 

and free space is listed. 

Command 

onstat -d > C:\Temp\onstat.txt 

 

Database Schema 

The database schema contains the SQL statements, which define the structure and properties of 

the database hppcdb with all its tables and columns. 

Command 

dbschema -d hppcdb > C:\Temp\dbschema.txt 

 

Database Backup 

The ontape utility creates a full backup of the OSCC database. 



 

P31003-S22B0-S102-2-7620                          08/2023 

OpenScape Contact Center V11, Troubleshooting Guide  

   27 

Documentation OpenScape Contact Center Enterprise 

System Management Guide 

 

Command 

ontape -s -L0 

 

Database Table Unload 

Use the unload statement in the Informix tool DBAccess to write the rows retrieved by any select 

statement to a file, e.g., to unload a single table of the hppcdb database. 

 

Command 

unload to 'C:\Temp\<table>.txt' select * from <table>; 

 

Replication States 

In a High Availability environment with or without CRS, the cdr list server command displays a list 

of the replication servers along with the replication states, that are visible to the server on which the 

command is run, which is Node 1, Node 2 and eventually CRS. 

Command 

cdr list server > C:\Temp\cdr-<n1|n2|crs>.txt 

 

The cdr list replicate command displays information about all the replicates on the server on which 

the command is run. The output can be filtered for the Inactive state, to see whether there is any 

problematic replicate. The Inactive state specifies that no database changes are captured, 

transmitted, or processed for the corresponding replicate. 

 

Command 

cdr list replicate | find “Inactive” 

cdr list replicate > C:\Temp\cdr-<n1|n2|crs>.txt 

 

2.1.8 Replication Tool 
In a High Availability environment with or without CRS, the replication is established with the OSCC 
tool trcdbins, which is executed on Node 1, Node 2 and eventually CRS. 

Documentation OpenScape Contact Center Enterprise 

Installation Guide 
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Tool Diagnostic 

trcdbins.exe trcdbins.00x 

 

Location 

C:\Program Files (x86)\OpenScape\Contact Center\ShareData\DIAGS 

 

2.2 OSCC Application Server 

2.2.1 OSCC Applications 
On the OSCC application server various applications (services) are running, depending on the 
licensed and activated feature set. Consequently, not all mentioned applications must write 
diagnostics. The OSCC applications are configured in the OSCC Application Server Configuration 
Center. Those configurations are written into xml files. 

Application Diagnostic Configuration 

Configuration Center configcenter*.log - 

Agent Portal Web webagent*.log webagent.xml 

Agent Portal Lite agentportallite.log agentportallite.xml 

Web Manager webmanager*.log webmanager.xml 

Mobile Supervisor osccwebservice*.log osccwebservice.xml 

Web Supervisor osccwebservice*.log osccwebservice.xml 

Virtual Agent 

Chat Bot & Speech Bot 

virtualagentservice*.log virtualagent.xml 

Open Media REST API openmediaws*.log openmediaws.xml 

Web Interaction REST API webinteractionsdk*.log webinteractionsdk.xml 

OSCC Client REST API restsdk*.log restsdkws.xml 

 

Location 

C:\Program Files (x86)\OpenScape\Contact Center\ApplicationServer\ ApacheWebServer\logs 

C:\Program Files (x86)\OpenScape\Contact Center\ApplicationServer\ ApacheWebServer\conf 
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Diagnostic Level 

The diagnostic level for each of the applications is set in the OSCC Application Server 
Configuration Center. For those applications, which are thought to be involved in the problematic 
scenario, set the diagnostic level to DEBUG, and keep the diagnostic level for the other applications 
on WARN. On heavy load systems consider, the diagnostic level to set at least to INFO, instead of 
DEBUG. GVS or DEV may request certain diagnostic levels. In reproducible scenarios consider, to 
reset the diagnostic level back to WARN, after the scenario has been captured. 

If size and transmission time of the diagnostics are not relevant, collect all the diagnostics of the 
whole directory (independent of time stamp and suspected problematic application). Otherwise, sort 
the diagnostics by column Date Modified and delete all older diagnostics not covering the scenario. 

In case the diagnostics needs to be captured for a longer time frame, or will be overwritten too fast, 
consider, to use a file copy tool. At least for the Agent Portal Web application the number of 
diagnostic files and their size can be configured in the OSCC Application Server Configuration Center. 

NOTE: For the Agent Portal Web application there is not only a server-side trace on the OSCC 

application server (Back-End), but also a client-side trace on the OSCC client machine (Front-End). 

See section OSCC Client machine. 

2.2.2 Apache Tomcat Webserver 
On the Apache Tomcat webserver, besides the OSCC applications, some system applications are 
running, and their diagnostic data is written into log files. 

Function Diagnostic 

Webserver startup & shutdown 

Deployment of applications 

Failure of subsystems 

catalina<date>.log 

 

Application activity 

HTTP requests between application and server 

localhost<date>.log 

localhost_access_log<date>.txt 

Apache Tomcat Manager applications 

manager.war, host-manager.war 

manager<date>.log 

host-manager<date>.log 

- tomcat8-stdout<date>.log 

tomcat8-stderr<date>.log 

- commons-daemon<date>.log 

 

Location 

C:\Program Files (x86)\OpenScape\Contact Center\ApplicationServer\ ApacheWebServer\logs 
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2.3 OSCC Open Media Connector Server 

The OSCC open media connectors for Facebook, Twitter and WhatsApp are installed on a separate 
OSCC open media connector server in the DMZ, beyond the local firewall. 

All OSCC open media connectors use an OpenSearch Elasticsearch database, which is applied on 
the OSCC open media connector server during installation of the connector. 

Database Diagnostic 

OpenSearch Elasticsearch elasticsearch.log 

 

Location 

C:\Program Files\OpenScape\Contact Center\Elasticsearch\logs 

 

2.3.1 Facebook 
 

Connector Diagnostic 

Facebook filelog-info*.log 

filelog-error*.log 

 

Location 

C:\Program Files\OpenScape\Contact Center\OpenMedia\social-media-hub-api\log 

 

Diagnostic Level 

The diagnostic level is set to ERROR and INFO by default and cannot be changed. 

2.3.2 Twitter 
 

Connector Diagnostic 

Twitter twitter_connector-<date>-*.log 
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Location 

C:\Program Files\OpenScape\Contact Center\OpenMedia\twitter-connector 

 

Diagnostic Level 

The diagnostic level is set to ERROR, WARN, INFO and DEBUG by default and cannot be changed. 

2.3.3 WhatsApp 
 

Connector Diagnostic 

WhatsApp WhatsAppConnector.log.* 

 

Location 

C:\Program Files\OpenScape\Contact Center\OpenMedia\whatsapp-connector\logs 

Diagnostic Level 

The diagnostic level can be changed on the WhatsApp Connector Configuration page on the tab 
Common Settings. The possible log levels are ERROR, WARN, INFO and DEBUG. 

Documentation OpenScape Contact Center Enterprise 

Open Media Connectors Deployment Guide 
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2.4 OSCC Virtual Agent Connector Server 

The OSCC virtual agent connector for Chat Bot and Speech Bot is installed on a separate OSCC 
virtual agent connector server in the DMZ, beyond the local firewall. 

Connector Diagnostic 

Virtual Agent VirtualAgentConnector-<date>-*.log 

 

Location 

C:\Program Files\OpenScape\Contact Center\Virtual Agent Connector\logs 

 

Diagnostic Level 

The diagnostic level can be changed on the Virtual Agent Connector Configuration page on the 
tab System. The possible log levels are FATAL, ERROR, WARN, INFO, DEBUG and TRACE.  

Documentation OpenScape Contact Center Enterprise 

Virtual Agent Connector Deployment Guide 

 

2.5 OSCC Client 

2.5.1 OSCC Design Database 
 The OSCC design database can be manually saved in Microsoft Access mdb format by the Manager 

application from the OSCC production database. The OSCC design database can be opened in the 

Manager application and in Microsoft Access as well. The default password is newton. 

Menu 

File > Save Database As… 

 

2.5.2 OSCC Error Log 
The OSCC error log contains all error messages of the OSCC servers mentioned in section OSCC 

Servers. The log can be obtained by the Manager application in the business unit SYSTEM. Save 

the error log in Microsoft Excel xls format. Alternatively, the error log can be obtained by an unload 

of the database table errorrecord from the database hppcdb with the Informix tool DBAccess. In 

this latter case, time stamps are in UTC. 

Menu 

View > Logs > Error Log Report 
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2.5.3 OSCC Change Log 
The OSCC change log contains all configuration changes done by users with the Manager 

application. The log can be obtained by the Manager application in the business unit SYSTEM. Save 

the change log in Microsoft Excel xls format. Alternatively, the error log can be obtained by an unload 

of the database table changelog from the database hppcdb with the Informix tool DBAccess. In 

this latter case, time stamps are in UTC. 

Menu 

View > Logs > Change Log Report 

 

2.5.4 OSCC User Activity & Source Activity Report 
In order, to better understand the sequence of actions of a user or source related to a problematic 

scenario, the User Activity Report resp. the Source Activity Report is useful. The activity reports 

can be obtained by the Manager application in the corresponding business unit. Save the activity 

report in Microsoft Excel xls format. 

Menu 

View > Activity Reports > User… 

View > Activity Reports > Source… 

 

2.5.5 OSCC Manager 
The diagnostics of the OSCC Manager application must be turned on via menu Tools > Options > 

User Settings > Advanced > General > Diagnostics and set to full level via the button Details… 

Application Diagnostic 

Manager Manager_<machinename>.00x 

 

Location 

C:\Users\<user>\AppData\Local\Unify\OpenScape Contact Center\Manager\Working 

 

Alternatively, a more extensive Manager diagnostic trace can be obtained by starting the Manager 

application from the Windows command prompt cmd. 

Application Diagnostic 

Manager OSCC8MR.log 
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Command 

tmcmain -d -st3111 -se2020 -L4 

 

Location 

C:\Users\<user>\AppData\Local\Unify\OpenScape Contact Center\Manager\Working 

 

NOTE: The directory AppData is eventually hidden in Windows Explorer and can be made visible 

through the Windows Explorer menu View > Hidden Items. 

OSCC System Monitor 

The diagnostics of the OSCC System Monitor application must be turned on via menu Tools > 

Options > Diagnostics and set to full level via the list box Custom and the button Configure… 

 

Application Diagnostic 

System Monitor SystemMonitor_<machinename>.00x 

 

Location 

C:\Users\<user>\AppData\Local\Unify\OpenScape Contact Center 

OSCC Agent Portal Web Front-End 

The Agent Portal Web diagnostic files on the client-side or front-end can be obtained from the 

machine, where the Agent Portal Web application runs in the browser. It is about diagnostics of the 

application itself and diagnostics of the browser. 

 

Application Diagnostics 

Traces from Agent Portal Web itself can be obtained by pressing simultaneously <CTRL> and 

<SHIFT> and clicking in the top bar of the Agent Portal Web application, next to the setting of the 

Device Preference. The button Diagnosis will appear in the top bar. When clicking on that button a 

window will open and it will be possible to make some settings. 

▪ Maximum size of the log. 

▪ Maximum amount of log history files. 

▪ Checkboxes to enable file logging and to enable console output. 

▪ Diagnosis levels Verbose, Debug, Info, Warnings and Error. 

 

Select all diagnostic levels and save the trace settings by clicking Apply Changes. The trace settings 

will be kept for subsequent Agent Portal Web sessions as well. For saving the traces after a 
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problematic scenario has been captured, click on Save current state log. The traces will be 

generated and downloaded into the browser and into the Windows Download folder.  

Application Diagnostic 

Agent Portal Web Front-End AgentPortal_Client-<date>_<time>.log 

 

NOTE: During an Agent Portal Web session, the diagnostics of the application are kept in memory 

of the client machine and are not available at some location in the Windows file system. Only at the 

point of time of the download, the diagnostics are available. As well, the diagnostics of a current 

Agent Portal Web session are cleared from the memory once the Agent Portal Web application is 

closed. 

 

In reproducible scenarios consider, to reset the diagnostic level back to Warnings, after the 

scenario has been captured. 

 

Browser Diagnostics 

Press <F12> to open, e.g., in Chrome, the Developer Tools to save Console and Network 

messages, which were logged while a scenario was executed. Before a scenario will be captured, 

clear the existing console and network messages by clicking on the Clear button in the upper left of 

the Developer Tools pane. Also make sure, that the console messages have a time stamp. For this, 

press <F1> or go to Settings in the upper right of the Developer Tools pane and then go to 

Preferences > Console > Show timestamps. Finally make sure, that the console messages of all 

levels are captured. For this, go to the upper right of the Developer Tools pane and then select under 

All levels the levels Verbose, Info, Warnings and Errors. 

 

In the Developer Tools pane, select the tab Console to show all messages, which arrived on the 

browser’s console. Right-click on the message pane and select Save as… Save the console 

messages in Windows Notepad log format. 

 

In the Developer Tools pane, select the tab Network to show all network messages. Right-click on 

the message pane and select Save all as HAR with content… Save the network messages in the 

special har format. 

2.6 OSCMS Server 

2.6.1 OSCMS Applications 
On the OSCMS server multiple applications (services) are running, depending on the licensed and 

activated feature set. Consequently, not all mentioned applications must write diagnostics. The 

OSCMS applications are configured in the Contact Media Service Configuration web application 

and eventually in additional web apps. 

Application Diagnostic 

Announcement Ports Call Director 

Basic IVR Call Director 

WebRTC Integrated Phone 

WebRTC Video/Screen Share 

Virtual Agent Speech Bot 

Call Recorder 

cms.log.* 

mediaserver.log.* 
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REST SDK 

Outbound Dialer dialer_service-<date>.log 

Customer Satisfaction csat_service-<date>.log 

 

The file prolog.txt contains in the section Database and Version all configurations of the Contact 

Media Service. 

 

Configuration Diagnostic 

Contact Media Service prolog.txt 

 

Location 

/opt/cms/log 

 

The number of diagnostic files per application can be configured in the Contact Media Service 

Configuration web application in the System pane and Diagnostics tab and can be set to a 

maximum number of 100. 

 

Instead of collecting the diagnostics manually from the diagnostics location in Linux, the complete 

log directory can be compressed and downloaded into the browser on the local machine and into the 

Windows Download folder via the link Download diagnostics. This set of diagnostics can be 

uncompressed by an appropriate program.  

 

 

 

 

 

If size and transmission time of the diagnostics are not relevant, collect the complete set of 

diagnostics from the whole directory, i.e., provide the file mentioned above with the compressed set 

of diagnostics. 

 

Diagnostic Level 

The diagnostic level is set in the Contact Media Service Configuration web application in the System 

pane and Diagnostics tab. It should be preferably set to DEBUG and will then apply to the cms logs. 

The diagnostic level of Outbound Dialer and Customer Satisfaction is by default DEBUG. 

 

On heavy load systems consider, the diagnostic level to set at least to INFO, instead of DEBUG. 

GVS or DEV may request certain diagnostic levels. In reproducible scenarios consider, to reset the 

diagnostic level back to WARNING, after the scenario has been captured. 

   Set of Diagnostics 

<date>_<time>_cms_log.tar.gz 
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2.6.2 OSCMS Voice Portal Nuance 
Another application of the OSCMS server is Voice Portal Nuance, which is installed in a docker. Its 

diagnostics are found in a location which is only accessible after having accessed the docker. Run 

the tool on the Linux command prompt under the root account. 

 

Application Diagnostic 

Nuance License Manager lm.log 

Nuance Speech Server nss1.log 

Nuance Speech Recognizer ASR nrs1.log 

Nuance Text Vocalizer TTS nvs-server1.log 

 

Command 

docker exec -it nuance /bin/bash 

 

Location 

/var/local/Nuance/system/diagnosticLogs 

 

The following docker command can be used to copy the diagnostics from the docker to the OSCMS 

host file system. If the target /opt/cms/log is chosen, then the diagnostics can be compressed and 

downloaded into the browser on the local machine, along with the OSCMS diagnostics. See section 

2.6.1. 

 

Command 

docker cp nuance:/var/local/Nuance/system/diagnosticLogs /opt/cms/log 

 

Part of the OSCMS Server is the Application Builder application. The Call Flow of an OSCMS 

Voice Portal application is contained in the export of a workspace from the Application Builder. In the 

export dialog, the archive file can be selected to export to, as well as which specific items to be 

exported. Details about the usage of the application are described in the documentation. 

 

Documentation OpenScape UC Application 

Fusion Application Builder – User Guide 

 

Application Diagnostic 
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Application Builder Call Flow 

 

Menu 

File > Export > Symvia Workspace Items… 

 

Instead of collecting the diagnostics manually from the diagnostics location in Linux, the diagnostics 

can be manually moved in Linux to the directory /opt/cms/log of the OSCMS applications diagnostic 

files. Then, these logs and those of the OSCMS applications can be downloaded in one step with the 

Contact Media Service Configuration web application, see section OSCMS Applications. 

2.6.3 OSCMS Media Server 
A central operational component of the OSCMS server is the OSCMS media server. 

Operational Component Diagnostic 

Media Server 
mediaserver.log.* 

mediaserver_warn.log.* 

 

Diagnostic Level 

The diagnostic level for the OSCMS media server needs to be set in the Java-based logging utility 

log4j. In most cases the log level needs to be FINE or FINEST. This level must be set manually in 

the log4j configuration file, in the logger tag for the involved functional components of OSCMS media 

server, as shown below. If the corresponding logger tag is not present, then it must be added 

manually. 

 

There are a lot of logger tags for various functional components of the OSCMS media server. 

Depending on the component affected, it is up to the media server team to instruct, which logger tag 

is to be set to which diagnostic level. At least for Telephony scenarios the relevant loggers are 

mentioned below, which usually need the diagnostic level FINE. 

Telephony – Voice 

<logger name=”com.cycos.connectivity.sip”> 

  <level value=”FINE” class=”com.cycos.media.logging.log4j.ExtendedLevel” /> 

</logger> 

<logger name=”com.cycos.connectivity.sip.messages”> 

  <level value=”FINE” class=”com.cycos.media.logging.log4j.ExtendedLevel” /> 

</logger> 

In case of WebRTC involvement, set the diagnostic level for module media.streaming as well 

(additionally). 

 

<logger name=”com.cycos.media.streaming”> 

  <level value=”FINE” class=”com.cycos.media.logging.log4j.ExtendedLevel” /> 

</logger> 
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The log4j configuration file can be edited by the Linux text editor vi or vim. To take the change effect 

for OSCMS media server, the OSCMS service must be restarted. 

 

Location 

/opt/Core/application_host/bin/log4j.xml 

 

In reproducible scenarios consider, to reset the diagnostic level back to INFO or WARN, after the 

scenario has been captured. 

 

 

3 3rd party Diagnostic Data 

3.1 Windows Server 

3.1.1 Windows System Information 
Windows System Information is a system profiler that displays diagnostic and troubleshooting 

information related to the operating system, hard- and software. 

Start the System Information from the Windows command prompt cmd and export the data from top-

level System Summary to Windows Notepad txt format. 

 

Application Diagnostic 

System Information <systeminfo>.txt 

 

Command 

msinfo32.exe 

 

Menu 

File > Export… 

3.1.2 Windows Event Viewer 
Start the Windows Event Viewer from the Windows command prompt cmd or from Windows 

Control Panel > System and Security > Administrative Tools > Event Viewer. Save the data to 

Windows Event Viewer evtx format. 

Application Diagnostic 

Event Viewer 

 

Application.evtx 

System.evtx 
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Security.evtx 

 

Command 

eventvwr.exe 

 

Location 

C:\Windows\System32\winevt\Logs 

3.1.3 Windows Error Reporting WER 
Windows Error Reporting is a crash reporting technology. It collects post-error debug information 

with memory dump files in case an application crashes or stops responding. Please read the 

documentation about using Windows Error Reporting. 

Documentation Using Windows Error Reporting 

https://learn.microsoft.com/en-us/windows/win32/wer/using-wer 

The generation of memory dump files is not activated by default and must be enabled. Please read 

the documentation about enabling memory dump files. 

Documentation Enabling Memory Dumps 

https://learn.microsoft.com/en-us/windows/win32/wer/collecting-user-mode-dumps 

 

Start the Registry Editor from the Windows command prompt cmd and set the registry values 

according to the table below by following the documentation above. 

   Command 

regedit.exe 

 

Registry Key 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Windows Error Reporting\LocalDumps 

 

 

Name Type Data 

DumpCount REG_DWORD 5 

DumpFolder REG_EXPAND_SZ C:\Temp\WER-Dumps 

DumpType REG_DWORD 2 

https://learn.microsoft.com/en-us/windows/win32/wer/using-wer
https://learn.microsoft.com/en-us/windows/win32/wer/collecting-user-mode-dumps
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Windows Error Reporting generates data in a directory of the dump folder above, which is named 

with the name of the crashing component. Otherwise, data is stored in the default location below. A 

corresponding entry at the associated point of crash time is written into the Windows Application 

Event log as well. 

Location 

C:\ProgramData\Microsoft\Windows\WER\ReportArchive\AppCrash_<component>.exe 

 

3.1.4 Windows Performance Monitor Perfmon 
Windows Performance Monitor captures various activities on a machine during a shorter or longer 

time frame, of which CPU usage and/or memory usage are of most interest.  

GVS OSCC has available three batch scripts: A batch script, with which a profile with appropriate 

metrics is created in the Performance Monitor; a batch script, with which subsequently the monitoring 

is started and a batch script, with which after an observation period the monitoring is stopped. The 

set of batch scripts can be obtained from GVS OSCC team for usage on your request, resp. will be 

provided for diagnostics on their request. 

 

It is not needed to start or stop the Windows Performance Monitor itself manually. Instead, execute 

each of the batch scripts for the intended purpose from the Windows command prompt cmd. 

 

Application Diagnostic 

Performance Monitor Perfmon 

 

CreatePerfLog<version>.bat 

StartPerfLog.bat 

StopPerfLog.bat 

 

Command 

perfmon.exe 

 

Location 

C:\PerfLogs\perf_oscc_<sequence-number>.blg 

 

3.1.5 Windows Process Monitor Procmon 
Windows Process Monitor is a monitoring tool that shows real-time file system, registry, and 

process/thread activity. The tool can be used, if, e.g., during installation, some component is reported 

to be “in use”, for which the installation cannot continue. The tool can be downloaded from Microsoft 

site.  

 

Download and Documentation Windows Process Monitor 
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https://learn.microsoft.com/en-us/sysinternals/downloads/procmon 

 

Start the tool before starting the installation of a Microsoft Installer msi or msp file and make some 

settings, here the process msiexec of Microsoft Installer: 

 

• Select from menu Filter > Filter. 

• Select from the list box Process Name. 

• Write in field msiexec.exe and Include only this process. 

• Add that process to the Processes to monitor. 

 

Start the installation process and run the installation until the error occurs. Save the log by menu 

File > Save and make some settings: 

• Events displayed using current filter plus checkbox. 

• Format CSV. 

• Select Path. 

 

3.1.6 Windows Cluster Log 
In a High Availability system, there are two OSCC main servers (Node 1 and Node 2) and an 

optional OSCC Central Reporting Server (CRS). Both nodes are part of the Windows Cluster, 

whereas the CRS isn’t. 

 

The Windows Powershell is an application of Windows in which command-lets can be executed. 

Windows Powershell can be either started by opening the application, or from the Windows command 

prompt cmd.  

Command 

powershell.exe 

  

The Windows Cluster Log can be obtained by the command-let Get-ClusterLog in the Windows 

Powershell. The diagnostic level of the Windows Cluster Log can be set by the command-let Set-

ClusterLog. The Windows Cluster Log can be obtained from both nodes of the cluster.  

 

Set the diagnostic level of the Windows Cluster Log to 5, by executing the command-let with the 

corresponding parameter. Five is the highest level containing Error, Warning, Info, Verbose and 

Debug. If no further parameter is specified, then the diagnostic level applies to the local cluster. 

Documentation Set-ClusterLog 

https://learn.microsoft.com/en-us/powershell/module/failoverclusters/set-clusterlog 

 

Powershell Command 

Set-ClusterLog -Level 5 

 

https://learn.microsoft.com/en-us/sysinternals/downloads/procmon
https://learn.microsoft.com/en-us/powershell/module/failoverclusters/set-clusterlog
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Generate the Windows Cluster Log for both nodes by executing the command-let without parameters. 

If done so, then the logs are generated for the local cluster and stored in the default directory on both 

nodes of the cluster. 

Documentation Get-ClusterLog 

https://learn.microsoft.com/en-us/powershell/module/failoverclusters/get-clusterlog 

 

Powershell Command Diagnostic 

Get-ClusterLog  Cluster.log 

 

Location 

C:\Windows\Cluster\Reports 

 

3.1.7 Windows Cluster Event Log 
The Windows Cluster Event Log is obtained from the Failover Cluster Manager application, which 

can be started from the Windows Administrative Tools. In the Failover Cluster Manager select 

Cluster Events on the left pane. Then, select Query on the right pane Actions, to define the criteria 

for which cluster events need to be displayed. In the window Cluster Events Filter select the 

following criteria: 

 

Cluster Event Filter Criterium 

Nodes <Node1> 

<Node2> 

Event Logs Microsoft-Windows-FailoverClustering-* 

Read only cluster events from the System log 

Level Critical 

Error 

Warning 

Informational 

Verbose 

From resp. To Date resp. Time Frame 

 

Save the Windows Cluster Event Log from the Failover Cluster Manager to Windows Event Viewer 

evtx format. 

 

Application Diagnostic 

https://learn.microsoft.com/en-us/powershell/module/failoverclusters/get-clusterlog
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Failover Cluster Manager <cluster-event-log>.evtx 

 

Command 

mmc.exe cluadmin.msc 

 

Menu 

Right-pane Actions > Save Events as… 

 

Location 

As chosen by user 

3.1.8 Windows Cluster Validation Report 
The Windows Cluster Validation Report can be obtained by the command-let Test-Cluster in the 

Windows Powershell, see section Windows Cluster Log for the usage of Windows Powershell. 

The command-let runs validation tests for the cluster and intends to do the following: 

 

▪ Find hardware or configuration issues before a failover cluster goes into production. 

▪ Help ensure that the clustering solution you deploy is dependable. 

▪ Provide a way to validate changes to the hardware of an existing cluster. 

▪ Perform diagnostic tests on an existing cluster. 

 

If the command-let is executed without parameters, then all applicable cluster validation tests are 

done on the local cluster and include both nodes without presenting the Wizard Validate a 

Configuration. After the tests run, the result will be written into the Windows Cluster Validation 

Report, which is a file in htm format. 

 

Documentation Test-Cluster 

https://learn.microsoft.com/en-us/powershell/module/failoverclusters/test-cluster 

 

Powershell Command Diagnostic 

Test-Cluster Validation Report <date-time>.htm 

 

Location 

C:\Windows\Cluster\Reports 

https://learn.microsoft.com/en-us/powershell/module/failoverclusters/test-cluster
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3.2 Windows Client 

Diagnostic data of the Windows client machine is usually not needed and if so, a specific request will 

be made after investigation of the problem by GVS/DEV. 

3.3 Linux Server 

3.3.1 Linux Logs 
The following diagnostics on the level of the operating system are available. 

 

Location 

/var/log/warn 

/var/log/messages 

 

The file prolog.txt contains besides the OSCMS configuration, the system information on the level 

of the operating system, e.g.: network interfaces, hard disks, CPU, memory, and operating system. 

 

Configuration Diagnostic 

Linux, Hardware, Vmware prolog.txt 

 

Location 

/opt/cms/log 

 

3.3.2 Linux Network Traffic 
Network traffic from and to the OSCMS server can be captured by the Linux tool tshark. To capture 

the traffic on the default network interface eth0, use the command below. If the tool should continue 

to run in a longer session in the background after the user logged off from the system, use the same 

command with the nohup prefix and the & postfix.  

 

If the output directory /opt/cms/log of the OSCMS applications diagnostic files is chosen, then this 

network trace and the diagnostics of the OSCMS applications can be downloaded in one step with 

the Contact Media Service Configuration web application, see section OSCMS Applications. The 

file format is pcap, which is also the format used by Wireshark. 

Command 

tshark -i eth0 -b filesize:30000 -w /opt/cms/log/tsharkcms.pcap 

nohup tshark -i eth0 -b filesize:30000 -w /opt/cms/log/tsharkcms.pcap & 

 

To stop capturing network traffic, press <Ctrl>C. To stop capturing network traffic as background 

task, use the following commands. 
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Command 

ps -ax | grep tshark 

kill <tshark-procid> 

3.4 Communication Platform 

Diagnostic data of the communication platform OSV, OS4000 and OSBiz is usually not evaluated by 

the OSCC team. In case an issue needs to be cross escalated, then the other team will determine, 

which diagnostic data is likely necessary to continue the investigation of the specific problem. In case 

a relationship of the problem with the communication platform is suspected by the service technician, 

then it is recommended to provide diagnostic data of the communication platform in advance. Please 

consult the document below, containing guidelines for opening tickets. 

Documentation Guidelines – Opening Tickets 

https://app-

enterprise.unify.com/gdmsproxy/retrieve?id=lr7omTdjomvp2VwXZE37BfIXGifo%2BpqcMi8fgi%2Fxu%2BaB

PJBCX1rw1g%3D%3D 

3.5 Corporate Email Server 

Diagnostic data of the corporate email server is usually not needed and if so, a specific request will 

be made after investigation of the problem by GVS/DEV. In case a relationship of the problem with a 

specific email is suspected or confirmed by the service technician, then it is recommended to save 

that problematic email from the OSCC Inbox or IMAP Working folder. The email must be saved in 

eml format with an appropriate email client, like e.g., Thunderbird. As emails are quickly moved 

upon arrival from OSCC Inbox to IMAP Working folder, in reproducible scenarios, the OSCC email 

server must be paused before arrival of the problematic email in the OSCC Inbox. 

 

In scenarios in which communications problems between the OSCC system and the corporate email 

server is suspected, e.g., delays, a trace of the network traffic is helpful. 

3.6 Corporate Web Server 

Diagnostic data of the corporate web server is usually not needed and if so, a specific request will be 

made after investigation of the problem by GVS/DEV. 

3.7 External IVR Machine 

The external IVR machine can be integrated in OSCC by either using the OSCC IVR API or by using 

the OSCC VoiceXML API, which latter is the modern approach of external IVR integration. 

3.8 External IVR and OSCC IVR API 

When using the OSCC IVR API, the IVR can be connected with an OSV, OS4000 or OSBiz 

communication platform. 

The IVR interacts with the caller and with the OSCC server to gather information. This information 

is used by the IVR to define the queue for the specific caller. Which information is gathered, is 

https://app-enterprise.unify.com/gdmsproxy/retrieve?id=lr7omTdjomvp2VwXZE37BfIXGifo%2BpqcMi8fgi%2FXu%2BaBPJBCX1rw1g%3D%3D
https://app-enterprise.unify.com/gdmsproxy/retrieve?id=lr7omTdjomvp2VwXZE37BfIXGifo%2BpqcMi8fgi%2FXu%2BaBPJBCX1rw1g%3D%3D
https://app-enterprise.unify.com/gdmsproxy/retrieve?id=lr7omTdjomvp2VwXZE37BfIXGifo%2BpqcMi8fgi%2FXu%2BaBPJBCX1rw1g%3D%3D
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defined by the customized IVR script. Finally, the IVR script will enqueue the call for a specific 

queue and OSCC will route the call to a user accordingly. 

Documentation OpenScape Contact Center Enterprise 

IVR API – Integration Guide 

 

Diagnostic 

IVR script 

IVR log 

 

3.8.1 External IVR and OSCC VoiceXML API 
When using the OSCC VoiceXML API, the IVR can be connected with an OSV or OS4000 

communication platform. 

This is a web-based solution with the involvement of a corporate web server to gather information 

by VoiceXML subdialogs. The IVR interacts with the caller and with the OSCC server through the 

corporate web server. The OSCC web interaction server acts as entry point for the requests. The 

information is used by the IVR to define the queue for the specific caller. Which information is 

gathered, is defined by the customized IVR script. Finally, the IVR script will enqueue the call for a 

specific queue and OSCC will route the call to a user accordingly. 

Documentation OpenScape Contact Center Enterprise 

VoiceXML – Integration Guide 

 

Diagnostic 

IVR script 

IVR log 

 

3.9 Processes crash / Memory leak 

Insufficient machine resources may cause crashes and memory leaks in OSCC, Application, and 

OSCMS servers. It is essential to adhere to the system requirements recommended in the 

respective guides for these servers. 

 

OSCC Servers 

System requirements for High Availability, Main, Central Reporting, and Auxiliary servers are 

described in the OpenScape Contact Center V11 R1 Installation Guide: 

• Chapter 3.1: System Requirements for High Availability 

• Chapter 4.1.1: System Requirements for a Main Server Machine 

• Chapter 4.2.1: System Requirements for a Central Reporting Server Machine 

• Chapter 4.3.1: System Requirements for an Auxiliary Main Server Machine 
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Application Servers 

System requirements for Application server are described in: 

• Chapter 4.7.1: Installing the OpenScape Contact Center Application Server on a Main Server 

Machine 

• Chapter 4.7.2: Installing the OpenScape Contact Center Application Server on a Separate 

Machine 

Java memory allocation for Tomcat must be configured using the tomcat8w.exe and tomcat9w.exe 

tools. For more information, please refer to the respective instructions in the OSCC Application 

Server installation guide. 

 

OSCMS Servers 

System requirements for the OpenScape Contact Media Service are described in the OpenScape 

Contact Media Service Guide: 

• Chapter 2.1: System Requirements for a Stand-Alone Server Machine 

NOTE: Additional configurations when using virtual machines are described in the OpenScape 

Solution Set V10 Guide, OpenScape Virtual Machine Resourcing and Configuration Guide: 

• Chapter 5.11: OpenScape Contact Center 

• Chapter 5.12: OpenScape Contact Media Service 

4 How-To-Solve Scenarios 

This section lists solutions for common problematic scenarios. 

4.1 Recover daily, weekly, and monthly roll-up data 

If for daily, weekly and/or monthly reports no data is presented, then rollups may have failed to 

propagate statistical data from the 15-minutes tables to the daily resp. to the weekly resp. to the 

monthly tables. 

Prerequisites 

For the procedure below make sure, that the 15-minutes statistical data is available for the 

problematic time frame and the problematic table(s), as this is the master data, which needs to be 

rolled-up. 

If the system is stand-alone, then ignore in the procedure below the steps about replication. If the 

system is in a high availability environment with or without central reporting server, then execute 

the steps of the procedure on each machine, for which statistical data needs to be rolled-up. 

Remove from the script below those lines, which tables do not need to be rolled-up, because all 

statistical data is in fact available. 

Procedure 

1. Stop the OSCC Service. 

2. Stop the replication. 

3. Use the Informix tool DBAccess to connect to the database hppcdb and execute the following 

SQL script to delete all statistical data from the daily, weekly, and monthly tables. 

 

delete from agentdaily; 

delete from agentmonthly; 

delete from agentweekly; 

delete from agentstatedaily; 

delete from agentstatemonthly; 

delete from agentstateweekly; 

delete from agentstatereasondaily; 

delete from agentstatereasonmonthly; 
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delete from agentstatereasonweekly; 

delete from callbackdaily; 

delete from callbackmonthly; 

delete from callbackweekly; 

delete from calltypedaily; 

delete from calltypemonthly; 

delete from calltypeweekly; 

delete from dnisdaily; 

delete from dnismonthly; 

delete from dnisweekly; 

delete from groupdaily; 

delete from groupmonthly; 

delete from groupweekly; 

delete from groupstatedaily; 

delete from groupstatemonthly; 

delete from groupstateweekly; 

delete from trunkdaily; 

delete from trunkmonthly; 

delete from trunkweekly; 

delete from wrapupreasondaily; 

delete from wrapupreasonmonthly; 

delete from wrapupreasonweekly; 

 

4. Restart the OSCC service. 

 

In this moment, the roll-ups will start and the statistical data for the daily, weekly, and monthly tables 

is re-created from scratch. Depending on the amount of data in the 15-minutes tables and the number 

of tables to be rolled-up, the roll-ups can take more or less time. 

 

5. Restart the replication. 

 

Recommendations 

 

• Make an Informix level 0 backup before starting the procedure. 
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4.2 Recover 15-minutes data from export files 

The OSCC statistics server will automatically create export files for data present in the temporary 

tables of the OSCC database (tables named with 1 and 2 at the end), if for some reason the content 

of those tables cannot be written to the corresponding permanent tables (same-named tables 

without 1 and 2 at the end) after each 15-minutes interval. This can happen permanently, e.g., due 

to a corrupt index of the table, or occasionally, e.g., due to a temporary lock of the table. 

 

When export files have been generated and the root cause of the issue is not present anymore, then 

it is necessary to load the content of those export files manually into the permanent tables of the 

OSCC database. For this purpose, development has implemented a batch script, that will insert the 

data into the database while doing some consistency checks. The batch script can be obtained from 

GVS OSCC team for your usage. 

 

The batch script will insert export data for the following tables:  

• agentfifteenmin 

• agentonoff 

• agentrecord 

• agentstatefifteen 

• agentstatereason 

• agentstatereasonfifteenmin 

• attemptlog 

• callbackfifteenmin 

• callbackrecord 

• callbackschedules 

• calldata 

• callrecord 

• calltypefifteenmin 

• cdcomponentfifteenmin 

• dnisfifteenmin 

• groupfifteenmin 

• groupstatefifteen 

• userpostprocessingreason 

• userpostprocessingreasonfifteenmin 

• workflowfifteenmin 

• wrapupreason 

• wrapupreaonfifteenmin 

 

Prerequisites 

If the root cause of the issue on the tables is caused by a bad index, then it is needed to fix the index 

first. The bad index, e.g., for table agentfifteenmin, can be found by executing the Informix command. 

 

Command 
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oncheck -cDIx hppcdb:agentfifteenmin 

 

In the output of this command a line would appear, like: 

 

ERROR: Index ix_agentfifteenmin for hppcdb:informix.agentfifteenmin is bad 

 

If so, the index for the table needs to be re-created, before running the batch script in the 

procedure below. The re-creation of the index is done by the following Informix commands, in 

either of both cases A resp. B. 

 

A. The index starts with ix_ 

This is not a unique index. 

 

Command 

drop index "informix".ix_agentfifteenmin; 

 

create index "informix".ix_agentfifteenmin on "informix".agentfifteenmin 

(recordtimestamp,agentkey,departmentkey,agentsite,busunitkey) using btree IN reporting_dbs; 

 

B. The index starts with uxpk_ 

This is a unique index. 

Command 

drop index "informix".uxpk_agentfifteenmin; 

 

alter table "informix".agentfifteenmin drop constraint "informix".pk_agentfifteenmin; 

 

create unique index "informix".uxpk_agentfifteenmin on 

"informix".agentfifteenmin(agentsite,recordkey,recordtimestamp) using btree IN reporting_dbs; 

 

alter table "informix".agentfifteenmin add constraint primary key(agentsite,recordkey,recordtimestamp) 

constraint "informix".pk_agentfifteenmin; 

 

The create index part (case A) resp. create unique index part (case B) of these Informix commands 

can be obtained from the Informix dbschema command, e.g., in the case of the agentfifteenmin 

table. 

Command 

dbschema -t agenfifteenmin -d hppcdb 

 

Notice that, at the end of the create (unique) index command, IN reporting_dbs has been added, 

in order to allocate the index on the right database space. Similar with the alter table part of the 

Informix command to define the exact syntax. 
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Procedure 

1. Copy the batch script insertexpfiles.bat to a folder on the OSCC Server. This folder must be 

named without blanks. 

2. Copy the export files (with extension exp), which need to be imported into the database to the 

same folder. 

3. In the Windows command prompt cmd under the informix user, execute the batch script. It is 

recommended to redirect the command output and error output to a file. The batch script can 

be executed while the OSCC system is running. It is not needed to stop the OSCC Service. 

Command 

insertexpfiles.bat > results.txt 2>&1 

 

The entries in the output file can be expected to look like this: 

 

Inserting data on agentfifteenmin table 

Database selected. 

Temporary table created. 

8 row(s) loaded. 

11 row(s) loaded. 

8 row(s) merged. 

Database closed. 

 

Recommendations  

 

• Make an Informix level 0 backup before starting the procedure. 

• If there are a lot of export files to be processed by the batch script, then execute the batch script 

multiple times with (smaller) portions, e.g., first with the export files of table agentfifteenmin1, 

then another time with the export files of table agentonoff2, etc. If "too many" data is to be 

processed at once, the procedure could take too long, timeouts could occur, and the batch script 

could fail. 

• Do not run the batch script, when the OSCC statistics server itself is moving data from the 

temporary tables to the permanent tables, i.e., not around the minutes 04, 19, 34 and 49. 
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4.3 Add new chunk to full database space 

The data of the Informix database is stored in multiple database spaces. Each database space can 

have one or more database chunks. If the database chunk(s) of a database space are full, then a 

new database chunk should be automatically created. Sometimes this does not happen, the OSCC 

system will become dysfunctional, and the Informix log will show corresponding errors. In that case 

a new database chunk must be added manually to the database space. 

 

Prerequisites 

The state of the database can be obtained by the Informix command onstat, which shows the 

database spaces in the upper part and the database chunks in the lower part. 

Command 

onstat -d 

 

Example Database Spaces 

 

Address number flags fch nch pgsize flags owner name 

c7e68e8 1 0x1 1 1 4096 N BA informix rootdbs 

e073018 2 0x1 2 2 4096 N BA informix physdbs 

e073230 3 0x1 3 1 4096 N BA informix logdbs 

e073448 4 0x8001 4 2 4096 N SBA informix sbspace 

e073660 5 0x1 5 2 4096 N BA informix admin_dbs 

e073878 6 0x1 6 1 4096 N BA informix realtime_dbs 

e073a90 7 0x1 7 3 4096 N BA informix reporting_dbs 

e073ca8 8 0x2001 8 1 4096 N TBA Informix temporary_dbs 

e074018 9 0x1 9 1 4096 N BA Informix processing_dbs 

e074230 10 0x1 10 1 4096 N BA informix web_dbs 

e074448 11 0x8001 11 1 4096 N SBA informix bts_dbspace1 

e074660 12 0x1 12 1 4096 N BA informix openmedia_dbs 

e074878 13 0x1 13 2 4096 N BA informix logical_log_dbs 

e074a90 14 0x8001 14 1 4096 N SBA Informix sbspace_000 

 

The above example shows that the database space physdbs with number 2 (column number) has 

two database chunks (column nch). 

Example Database Spaces 

address ch dbs offset size free bpages flags 

pathname 

c897018 1 1 0 192000 177808  PO-B-D 

D:\Programme\Informix\storage\rootdbs.000 

e076018 2 2 0 6656 6603  PO-B-D 

D:\Programme\Informix\storage\plogdbs.000 

e077018 3 3 0 168192 203  PO-B-D 

D:\Programme\Informix\storage\llogdbs.000 
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e078018 4 4 0 8192 7576 7576 POSB-D 

D:\Programme\Informix\storage\sbspace.000  

e079018 5 5 250 392966 384532  PO-B-D  

d:\Programme\Contact Center Data\admin_chunk1 

e07a018 6 6 250 524038 504609  PO-B-D  

d:\Programme\Contact Center Data\realtime_chunk1 

e07b018 7 7 250 5242630 432857 PO-B-D  

d:\Programme\Contact Center Data\reporting_chunk1 

e07c018 8 8 250 524038 523985  PO-B-D  

d:\Programme\Contact Center Data\temporary_chunk1 

e07d018 9 9 250 1048326 999469 PO-B-D  

d:\Programme\Contact Center Data\processing_chunk1 

e07e018 10 10 250 261894 261061  PO-B-D  

d:\Programme\Contact Center Data\web_chunk1 

e07f018 11 11 250 261894 244514 244534 POSB-D  

d:\Programme\Contact Center Data\bts_chunk1  

e080018 12 12 250 1048326     1037772 PO-B-D  

d:\Programme\Contact Center Data\openmedia_chunk1 

e081018 13 13 250 384000 23947  PO-B-D  

d:\Programme\Contact Center Data\logical_log_chunk1 

e082018 14 14 0 2500 2242 2253 POSB-D 

D:/Programme/Informix/storage/sbspace_000 

e083018 15 2 250 255500 0  PO-B-D 

D:\Programme\Informix\storage\phys_chunk2 

e084018 16 4 250 254000 237208 237208 POSB-D 

D:\Programme\Informix\storage\sbspace_chunk2 

e085018 17 7 250 268500 67936  PO-B-D  

d:\Programme\Contact Center Data\reporting_chunk2 

e086018 18 13 250 1048750 48747 PO-B-D  

d:\Programme\Contact Center Data\logical_log_chunk2 

e087018 19 7 250 5000000     4277764 PO-B-D  

d:\Programme\Contact Center Data\reporting_chunk3 

e088018 20 5 250 250000 249997  PO-B-D  

d:\Programme\Contact Center Data\admin_chunk2 

 

The above example shows that the database space with number 2 (column dbs) has two database 

chunks, with numbers 2 and 15 (column ch): 

D:\Programme\Informix\storage\plogdbs.000 with 6603 pages free  

D:\Programme\Informix\storage\phys_chunk2 with 0 pages free 

As database chunk plogdbs.000 is almost full and database chunk phys_chunk2 is completely full, 

the database space physdbs can be considered as full. It is needed to add a third database chunk 

phys_chunk3 at the same location to the database space physdbs. 

 

Procedure 
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This procedure is to be applied on each database space, which was found to be full. 

1. In order to create a database chunk with the Informix command onspaces in step 2, the file 

must be already there with that name. So, create a text file with size zero and rename it to the 

desired name. 

File 

D:\Programme\Informix\storage\phys_chunk3 

 

2. In the Windows command prompt cmd under the informix user, execute the following 

commands with the database space in option -a resp. -d and with the database chunk in 

option -p. The command can be executed while the OSCC system is running. It is not needed 

to stop the OSCC Service. 

Command 

onspaces -a physdbs -p “D:\Programme\Informix\storage\phys_chunk3” 

-o 0 -s 1048076 

  

onparams -p -s 1000000 -d physdbs 

NOTE: The second command onparams is only necessary to execute in case a database chunk is 

added to the database space physdbs, not for adding a database chunk to other database spaces. 

 

Recommendations 

• Make an Informix level 0 backup before starting the procedure. 

• After the commands have been executed, verify with the command onstat, that the new 

database chunk has been added correctly. And verify in the Informix log, that messages about 

full database spaces do not occur anymore. 

• In case of a high availability system, add the database chunk to the database space on both 

nodes for reasons of symmetry, even if no issue is observed on the other node. 
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